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Introduction

Bluetooth is an open specification for a cutting-edge technology that enables short-range
wireless connections between desktop and laptop computers, personal digital assistants,
cellular phones, printers, scanners, digital cameras and even home appliances — on a
globally available band (2.4GHz) for worldwide compatibility. In a nutshell, Bluetooth
unplugs your digital peripherals and makes cable clutter a thing of the past. Now you can
connect your PDA or PC to Bluetooth™ enabled mobile phone with this Bluetooth™

adapter.

You can access e-mail & Internet no matter where you are with just a little help from your

Bluetooth™ mobile phone.
Plus, when you are back in the office, you can hook yourself up to your office network as
well as communicate with other Bluetooth™-enabled devices.




Chapter1

Supported profiles
Windows 98SE/ME

This Bluetooth Stack for Windows supports the following profiles. Please note that
profiles HSP, PAN, BIP, A2DP, AVRCP and GAVDP are supported by Windows XP and
Windows 2000 only.

(a) Dial-Up Network (DUN)

(b) Fax profile (FAX)

(c) Local Access Profile (LAP)

(d) Serial Port Profile (SPP)

(e) Human Interface Devices (HID)

(f) Hard Copy Replacement Profile (HCRP)

(g) File Transfer Profile (FTP)

(h) Object Push Profile (OPP)

Windows 2000/XP

(a) Dial-Up Network (DUN)

(b) Fax profile (FAX)

(c) Local Access Profile (LAP)

(d) Serial Port Profile (SPP)

(e) Human Interface Devices (HID)

(f) Hard Copy Replacement Profile (HCRP)




(g) File Transfer Profile (FTP)

(h) Object Push Profile (OPP)

(i) Headset Profile (HSP)

(j) Personal Area Network (PAN)

(k) Basic Imaging Profile (BIP)

(I) Advanced Audio Distribution Profile (A2DP)
(m) A/V Remote Control Profile (AVRCP)

(n) Generic Audio Video Distribution Profile (GAVDP)

Supported languages

The Bluetooth Stack for Windows supports the following languages.

English
Danish
French
German
Italian
Japanese
Norwegian
Spanish
Swedish

The following languages are supported by Windows XP and Windows 2000 only.

Dutch

Korean

Simplified Chinese
Traditional Chinese
Russian

Finnish

Portuguese (Brazil)

Supported operating systems
The Bluetooth Stack for Windows supports the following operating systems.
Windows 98 Second Edition

Windows ME
Windows 2000 Professional (Service Pack 3 or above)




Windows XP Professional (Service Pack 1 or above)
Windows XP Home (Service Pack 1 or above)
Windows XP Tablet PC Edition

Windows XP Media Center Edition

Limitations
(a) External Bluetooth drivers cannot be "signed drivers" to receive Microsoft WHQL logo.
Therefore, Microsoft's "Unsigned driver" warning messages may pop up during the

software installation, Bluetooth headset, mouse or keyboard setup. Please install the
drivers and then follow the on-screen instructions.

(b) On Swedish Windows XP, an error message (error code = 633) may be seen during
dial-up. Please update the operating system to Windows XP Service Pack 2 or refer to
Microsoft knowledge base #831717.

(c) Windows XP fast user switch is not supported. When switching to another user, the
Bluetooth Manager is not launched. Please log off before switching to another user.

(d) If "automatic FAX receiving" is enabled on Microsoft FAX manager, and if DUN, FAX,
or LAP profile icon is registered on Bluetooth Settings, and then Bluetooth's "resume from
standby" may take a couple of minutes to turn on.

(e) Windows 98 Second Edition: If the "Install New Modem" dialog pops up when setting
up a Bluetooth modem, mobile phone, or access point, please choose "Don't detect my
modem; | will select from a list". Otherwise, the system may freeze during the modem
detection. If the manual for your Bluetooth device does not specify a modem driver, then
please select "Standard 33600bps modem".

(f) Before connecting or disconnecting a Bluetooth headset, please exit any voice or
sound-related applications (e.g. Windows Messenger, Windows Media Player). The
audio input and output may not be switched properly if those applications are running.
This same precaution is important prior to system standby, hibernate or shutdown, and
prior to turning off or unplugging the primary Bluetooth device.




Chapter2
Setup for Windows 98SE/ME/2000/XP

Installing Bluetooth software for Windows

1. Please insert the accompanying CD and the setup menu should launch
automatically. If the setup menu does not launch automatically, use Windows
Explorer to navigate to the appropriate CD-ROM drive and run "setup”.

Setup Program

2. When the License Agreement screen is displayed, read the License Agreement, then
click the radio button to the left of "l accept" and then click the “Next“ button.




Bluetooth Stack for Windows by Toshiba Setup

TOSHIBA CORPORATION el
End User License Agreement

This End User License Agreement (EULA) is a legal agreement between you and
TOSHIBA CORFPORATION (TOSHIBA) with regard to the copyrighted Software provided
with this ELILA.

Use of any software and related documentation (Software) made awvailable by

downloading or otherwise to wou by TOSHIBA in whatewer form or media, will constitute

wour acceptance of these terms, unless separate terms are provided by the software |
supplier. inwhich case cerain additional ar different tarms may apply. fyou do not agree |v

+ laccept

" | dan't accept

(0] Cancel

3. During the installation, the system will try to detect your Bluetooth device, please plug
in your Bluetooth device and then click on the “OK” button.

Bluetooth Stack for Windows by Toshiba Setup

\!}) Please plug in the Eluetooth device and dlick Ok button,

Zancel

4. When the installation is completed, please click on the "Yes" button to restart your
system.

Bluetooth Stack for Windows by Toshiba Setup

i You rusk restart your swsem For the configuration changes made to Eluetooth Skack For wWindows by Toshiba to take
effect. Click ¥es to restart now ar Ma if vou plan ko restart later,




Chapter 3

Basic setting

Methods for registering new devices using the Bluetooth Utility shall now be described.
A Bluetooth mouse shall be connected and set up using [Bluetooth Settings] as an
example.

[Bluetooth Settings] provides two set-up methods: "Express Mode" and "Custom Mode."

o« Express Mode
[Bluetooth Settings] will automatically detect and register services. If several
services (profiles) are supported by the device the service that has been set to the
highest priority shall be selected and registered.
Express Mode is normally recommended for device set-up.

e Custom Mode
After having been detected, the services supported by the device are displayed as
a list, from which you can select the desired function(s).
Custom Mode must be used to set up a device if, for example, you wish to use a
modem station to send a fax (because in Express Mode, the DUN profile will be
automatically selected since it has a higher priority than the FAX profile).

The differences between setting up the same device (a Bluetooth mouse) using Express
Mode and Custom Mode are described on the following pages.

3.1 Express Mode Set-up

3.1.1 Starting Bluetooth Settings

. . Registerin
Starting Bluetooth Detecting . . B _g
. g . »| Detecting services ¥ settings
Settings Bluetooth devices . =,
information

1. Click [Start]=2>[All Programs]—>[Bluetooth]>[Bluetooth Settings].
(Under Windows 2000, click [Start]—[Programs]—[Bluetooth]—[Bluetooth
Settings].)




Note
- The same result can be achieved by right-clicking on the Bluetooth icon in the

task tray and selecting [Bluetooth Settings] from the menu that appears.

Bluetooth Settings

Add New Connection

Options

Help
Exit

| % 10:29 PM

The [Bluetooth Settings] window below will appear when other devices have
already been registered.

' Bluetooth Settings okl
Bluetooth View Help
- € Bluetooth

(@t ] [ ods |

Please click the [New Connection] button to open the [Add New Connection Wizard]
window. If no devices have been registered yet, please proceed directly to
"Detecting Bluetooth Devices."

3.1.2 Detecting Bluetooth devices

i i Registering
Starting Bluetooth Detecting . . !
1 o - L [) tect S - sett
Settings Bluetooth devices ctecting services _ settings
information

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] window
will appear.




. Switch the device power ON to make it connectable via Bluetooth.

. Confirm that [Express Mode] has been selected in the [Add New Connection
Wizard (Welcome to the Add New Connection Wizard)] window, and click on
the [Next] button.

‘Add New Connection Wizard

Welcome to the Add New Connection Wizard

Thiz wazaid regsters the connection infomation of a remole
dewica.
Select the wizard made.

(%) Exprezs Mode [Recommended)
The most uzedul zervice on a remote device is et up,

() Cugtom Mode
An avalable senice on a remole device 15 selected and sot
up.
| Met » | [ Cancal ]

Searching for Bluetooth devices will start.

Add Hew Connection Wizard

Searching for Bluetooth devices.

Seanching fos Blustooth devices.

When the device has been detected, the name and address of the device will
appear in the [Add New Connection Wizard (Select Device)] window.




‘Add New Connection Wizard

Select a device

Pleass choose the Bhustooth device you wish bo use.

Bluetooth device addiess

Dievice izt
: Dewice Hame Device Addiess -ﬁ..
| BT Momed e/ i

b

[ <Back ]| Mews> | [ Cancal ||

Note
- If no device is found, please confirm that the device has been made
connectable via Bluetooth, and click on the [Update] button.
- A further device search will be performed.

3.1.3 Detecting services

. . Registering
Starting Bluetoath Detectin . . .
et > = » Detecting services settings
Settings Bluetooth devices . .
information

1. Select the device name from [Device List] and click on the [Next] button.
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‘Add New Connection Wizard

Select a device

Pleass choose the Bhustooth device you wish bo use.

Bluetooth device addiess

Dievice izt
: Dewice Hame Device Addiess -ﬁ..
| BT Momed e/ i

b

[ <Back ]| Mews> | [ Cancal ]

Bluetooth device detection will commence.

Note

- If several services (profiles) are supported by the device, the service that has

been set to the highest priority shall be automatically selected and set up in
Express Mode. Please use Custom Mode if you wish to select desired services

Add Hew Connection Wizard

Pleaze wait while wizard searches for remote device services.

The local device iz searching for remote: davice senices.

manually.

- When a service has been detected, a window prompting you to enter the
Bluetooth passkey (PIN code) may appear. Please enter the passkey and click

on the [OK] button.

11




Bluetooth Manager - Bluetooth Security

Eluetocth Passkey [FINL
‘%]ﬂ {F et blarik, the dafaul PIN wil be used )
Request Dievice
EBlustooth Device Addiess;  00:07,61;01:B1:0E
Eluetooth Device Mamea: BT-Mouse.1

[ ox ][ cenea |

- If you have not entered your Bluetooth passkey after a certain amount of time
has passed, the connection process will be cancelled for security reasons.

Please perform the passkey entry process again.

A message will appear prompting you to prepare the device for connection.

2. Click on the [OK] button.

Bluetooth Settings

4
Jl) Prepare to conned: bo the remote HID device, then dick Ci.

Note
- When the settings information has been registered, a window prompting you to

enter your Bluetooth passkey (PIN code) may appear. Please enter your passkey
and click on the [OK] button.

Bluetooth Manager - Bluetooth Security

Blustocth Passkey [PINL
‘_"ﬁ]ﬂ (IFleft bk, the defaudt PIN will be used)
Request Device
Blustooth Device Addiess;  00:0761:01:B1:0E
Eluetooth Device Mama: BT-Mousze.1

[ ok ][ cane |

- If you have not entered your Bluetooth passkey after a certain amount of time

has passed, the connection process will be cancelled for security reasons.
Please perform the passkey entry process again.

12



The [Add New Connection Wizard (Connection Name Setup)] window will appear if
a service has been properly detected.

3. Select the type and name of the icon to be displayed once the device has
been registered, and click on the [Next] button.

Add Hew Connection Wizard

Enter a name and zelect an icon.

Setup the connechon name and icon.

Sethng indomnation
Connection Mame:

BT-Mouze1

6 | Change lcons...

[ ] Creste & shartcat on the deskiop

[ <Back ]| Mews | [ Cancel |

Note
- If you wish to change the icon, please click on the [Change Icon] button and
select your preferred icon from the list that appears.

Change Icons %]

BslmOMs |
mdEO8QE
C=F3= 1 W TeI)!
me@[l %9
WE]_(=E5E53

13



3.1.4 Registering settings information

Starting Bluetooth Detecting . ) Rﬁgmtenng
Settings "| Bluetooth devices | | DEteetng services settings
information

The [Add New Connection Wizard (Completing the Add New Connection Wizard)] window
will appear.

1. Click on the [Finish] button

Add Hew Connection Wizard

Completing the Add New Connection Wizand

Regshabion of connechon infoimation complete.

[ <Back || Finsh | [ Cancal ]

The [Bluetooth Settings] window will appear.
The icons of the registered devices will appear, and the devices will be ready to
use.

' Bluetooth Settings = |
Bhestooth  View Help

£ Bluetooth

BT-Mouse-1
e @ Detai. | | 3§ Deleta
Conneckian

14



3.2 Custom Mode Set-up

3.2.1 Starting Bluetooth Settings

1.

. . Registering
S E ]?1 h g Dc:tcctmg_ »| Detecting services settings
Settings Bluetooth devices information

Click [Start]=>[All Programs]—>[Bluetooth]>[Bluetooth Settings].
(Under Windows 2000, click [Start]—[Programs]—[Bluetooth]—[Bluetooth
Settings].)

Note
- The same result can be achieved by right-clicking on the Bluetooth icon in the
task tray and selecting [Bluetooth Settings] from the menu that appears.

Bluetooth Settings

Add New Connection

Options

Help
Exit

| Es 10:29 PM

The [Bluetooth Settings] window below will appear when other devices have
already been registered.

L Bluetooth Settings =<
Bluetooth  Wiew Help
.; ~ 3 Blugtooth

(@oeta] (€ oo |

Mooy s
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Please click the [New Connection] button to open the [Add New Connection Wizard]
window. If no devices have been registered yet, please proceed directly to
"Detecting Bluetooth Devices."

3.2.2 Detecting Bluetooth devices

. . Registeri
Starting Bluetooth — g Detecting services Zilt:i:r ; :

Settings "| Bluetooth devices ] g! i A
information

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] window
will appear.

1. Switch the device power ON to make it connectable via Bluetooth.

2. Confirm that [Custom Mode] has been selected in the [Add New Connection
Wizard (Welcome to the Add New Connection Wizard)] window, and click on
the [Next] button.

Add New Connection Wizard

Wealcome to the Add Mew Connection Wizard

Thiz vazard regisbers the connechon information of & remobe
davica,
Select the wizard made.

() Exprezs Mode [Recommended)
The mioet useful zervice on a remobe device iz set up.

(%) Cuztom Mode
An avalable service on a remole device 13 seleched and set
up.
[ Heut » ] [ LCancal ]

Searching for Bluetooth devices will start.

16



Add Hew Connection Wizard

Searching for Bluetooth devices.

Searching for Bluetooth devices:

When the device has been detected, the name and address of the device will
appear in the [Add New Connection Wizard (Select Device)] window.

‘Add New Connection Wizard

Select a device

Pleass choose the Bhustooth device you wish bo use.

Bluetooth device addiess

Dievice izt
: Dewice Hame Device Addiess -ﬁ..
| BT Momed e/ i

b

[ <Back ]| Mews> | [ Cancal ]

Note
- If no device is found, please confirm that the device has been made
connectable via Bluetooth, and click on the [Update] button.
- A further device search will be performed.

17



3.2.3 Detecting services

. . Registerin
Starting Bluetooth Detecting gistering
. > . settings
Settings Bluetooth devices . .
information

1. Select the device name from [Device List] and click on the [Next] button.

=1

‘Add New Connection Wizard L J

Select a device

Pleass choose the Bhestooth device you wash bo use.

Blustooth device addiess

Dievice izt
| Dawice Mams Device Addies:
| BT MouseT o TADECESY

| ET-Madem 0003 7A:03:48:46

e o) |

Bluetooth device detection will commence.

‘Add New Connection Wizard R

Pleaze wait while wizard zearches for temote device zervices.

The local device iz searching for remote: davice senices.

18



Note
- When a service has been detected, a window prompting you to enter the

Bluetooth passkey (PIN code) may appear. Please enter the passkey and click
on the [OK] button.

Bluetooth Manager - Bluetooth Security

Eluetocth Passkey [FINL
ﬁ {IF It blarik, Hye defsull PIN will be used |
Request Dievice
Elustooth Device Addiess:  00:07.61:001:81:DE
Eluetooth Device Mamea: BT-Mouse.1

[ ox ][ cenea |

- If you have not entered your Bluetooth passkey after a certain amount of time
has passed, the connection process will be cancelled for security reasons.
Please perform the passkey entry process again.

- If you try to register a device that has already been registered, the following
message will appear, and you will not be able to proceed with further operation.
Please click on the [OK] button to close the message.

Bluetooth Settings &3

! E Thes HID device Is already registered.

The services supported by the device will be displayed.

2. Select the desired service and click on the [Next] button.

19



Select a service.

Pleaze chooze the zerace to use.

Service zelaciion

Senvice Class Sesvice Mame
i Human Interface Device Cordess Pieserter

£ | [ [l

[ <Back || News | [ Concel ]

Note
- When a device supports several services
If the device supports several services, you can use Custom Mode to manually
select the services (profiles) you wish to use from the list that appears under
[Select Services].

Example: List of wireless modem station services

Sernce zelaction

Servica Clase Service Mama

(i Distup Netwo... Dislup netwaiking
[iFax Fax
B Saial Forl Serial Pout

If Express Mode is used to perform the set-up, the highest-priority service in the
device will be automatically selected and configured.

3. Click on the [OK] button.

-

Bluetooth Settings &

-
\"‘ll) Prepare to connedt bo the remote HID devica, then dick Ci.

20



Note
- When the settings information has been registered, a window prompting you to

enter your Bluetooth passkey (PIN code) may appear. Please enter your passkey
and click on the [OK] button.

Bluetooth Manager - Bluetooth Security

Elustooth Passkey [FINY
““ﬁ’% (IFleft bk, the detaudt PIN wil be used)
Request Device
Elustooth Device Addiess:  00:07.61.00:B1:DE
Eluetooth Device Mamea: BT-Mouse.1

Lok ][ cens ]

- If you have not entered your Bluetooth passkey after a certain amount of time

has passed, the connection process will be cancelled for security reasons.
Please perform the passkey entry process again.

The [Add New Connection Wizard (Connection Name Setup)] window will appear if a
service has been properly detected.

4. Select the type and name of the icon to be displayed once the device has
been registered, and click on the [Next] button.

Add Hew Connection Wizard

Enter a name and zelect an icon.

Setup the connechon name and icon.

Sethng indomnation
Connection Mame:

BT Mouzs

6 | Change lcons...

[ ] Creste & shartcat on the deskiop

[ <Back ]| Mews | [ Cancel |

21



Note
- If you wish to change the icon, please click on the [Change Icon] button and
select your preferred icon from the list that appears.

Change Icons %]

FSlmOnS
mTEOQE
mnis g @I
sas @I w9

1E]_{=NaRegri

[ ok |[ cancs |

22



3.2.4 Registering settings information

Starting Bluetooth Detecting L Regi renng
Settings *| Bluetooth devices *| Detecting services : settings
information

The [Add New Connection Wizard (Completing the Add New Connection Wizard)] window
will appear.

1. Click on the [Finish] button

Add Hew Connection Wizard

Completing the Add New Connection Wizand

Regshabion of connechon infoimation complete.

[ <Back || Finsh | [ Cancal ]

The [Bluetooth Settings] window will appear.
The icons of the registered devices will appear, and the devices will be ready to
use.

23



) Bluetoath

@m] | 7€ etete |
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Chapter 4
Making the most of your Bluetooth device

4.1 Connecting to the internet
41.1 Connecting to the internet using a modem station
Setting up the modem station
1. Turn on the wireless modem station.

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New
Connection].

Bluetooth Settings

Add Mew Connaction
Diendce Properties

Power OFF

Ciphions [

Hedp
Exit

- ¥ Qs

Note
- Alternatively, click [Start]—[All Programs]—[Bluetooth]—[Bluetooth Settings],

and then click on [New Connection] from the active [Bluetooth Settings] window.

3. Confirm that [Express Mode] has been selected, and then click on the [Next]
button.

25



r'l.dd Hew Connection Wizard

Thiz wizard will create the zettings for Bluetooth device connection.

Pleass ensure pour Blustooth devices are on and zet to
dizcoverable.

(%) Expuess Moda [Recommended

() Cugtom Mode
Thiz: alloves pou to set the detals for the cormechion.

rere | |- ]

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will
appear.

"l.dd Hew Connection Wizard

Searching for Bluetooth devices.

Seaiching for Bluetooth devices.

4. Select the device name of the wireless modem station from [Device List], and
then click on the [Next] button.

26



T Tow Connaction Wizard

Select a device

Pleass choose the Bhastooth desvice you wish bo use.

Blustooth device

Drevica Mame

PocketPC:
£ Bletaoth Printer

|_ + Back ][_ﬂaan ][ LCancal ]

The [Add New Connection Wizard (Searching for Services)] window will appear.

r'|l|n|1:|1 Hew Connection Wizard

Pleaze wait while the wizard connect: to a remote device.

The local device iz connecting lo the iemate device
ZAMVICE,
Pleaze wail

Once a service has been detected successfully, connection to the device and COM
port creation will be performed automatically, after which the [Add New Connection
Wizard (Modem Settings)] window will appear.

. If you are connecting to a wireless modem station for the first time, enter the
passkey for the modem station under [Bluetooth Passkey (PIN code)], and
then click on the [OK] button.

27



Bluetooth Manager - Bluetooth Security

Blustooth Passkey [FINL Ty
%ﬁﬂ {F edt blarik, the default PIN vl be used )
Request Device

Elustooth Device Addiess.  D0;00:00:00:00;00
Bluetooth Device Mamea; TOSHIES BT Modem

Lok ][ cens ]

Once the program has finished searching for the devices, the [Add New
Connection Wizard (Device Selection)] window will appear.

6. Click on the [Next] button.

tﬁdd Hew Connection Wizard

Advanced Modem Setlings

Fleasze chok the “advanced Modem Settings”” button
fiee Purther conhiguestion options (&0, lar HSCSD o
GPRS] or click “Hext" o contines.

| Schvanced Modem Setlings... |

f<Back | Mews || Cacal |

Certain modems require you to configure initialization commands separately.
Please click on the [Additional initialization Command Settings] button, enter the
initialization commands in the following window, and then click on the [OK] button.

Note
- Please refer to the modem or mobile phone instruction manual for further detail
or mobile phone instruction manual for further details on initialization commands.

28



‘Advanced Modem Settings E

‘fou can anbar gpecial AT-Commands fos the mstalled modem. This
may be necessany fod some connections. &.9. GFRS and HSCSD

Flease check the homepage of your provider and your mobil phone
vendor io gel the coinect setings. These seltmgs wall vary betwesn
differant mobide phoess vendors and prowiders.

Examples:

GFRS5: +I:.EEI-|I|-HT =1,"IP" "apn.provider. de™
HSCSD: «CBST=81.0,1:+CHSN-4.0.0.0

Estra inkializabion commands:

[ ok | [ Cancel |

7. Enter the connection name (optional), telephone number (of your provider's
access point), user name and password (as issued by your provider), and
then click on the [Finish] button.

r‘“dd Haew Connection Wizard

Create dial-up connection

Please give the dislup connechon a name, telephone
number, and ¥ requited, 3 wuser name and password

Dialup connection name: || andon 4

Telephone nurmber, (207 957 6543
Lo Flewnes igoody 53
Pagsmand: ssEsEsns e
Confiom password: LTI TTTITT Y
[#] Set s Defaut Diskup
[ <Back ]| Finish | [ Cancel |

Important
- The sample entries shown in the window are provided solely for purpose of

explanation. Please use your own telephone number, ID and password
according to the arrangement with your provider.

The settings will be registered, and an icon will appear in the [Bluetooth Settings]
window.

29



London &

Connecting to the Internet
1. Start your browser, e-mail application or other application

Important
- Please enter the e-mail settings separately if you are going to use e-mail (the
set-up method will vary with the application).

2. Enter the URL of the Web page you wish to display and then press the [Enter]
key, or use the e-mail tool to send/receive items or perform other activities.

The [Dial-up Connection] window will appear.

3. Click on the [Connect] button

Dial-up Connection ﬁ
M- Select the sesvice wou want bo connect
ﬂ to, and then entes pour user nams and
passward,
Copnecltoc  |London & ™
Llser name: rgocdy @9
Passweed SEEESSEEESRENNAN
[+#] S ave pazsword

[]Connect automaticaly

[_Connect | | Settings.. | [ Wicek Qffine |

Important
- A connection will be automatically established with the modem station if COM

Auto Connect is available. If COM Auto Connect is not available, please
manually connect to the modem station.

The following message will appear once you have connected to the Internet.

I,., London & is now connected -

Spead: 115.2 Ebps

30



4. End the connection

The window below will appear if you double-click on the:yicon in the task bar.

i London A Status L:’_]
Germral | Dietails

Conneclion
Staluz: Conreched
Diuratian; 00006
Speed 1152 Kbps

Acinaly

— N — ;
Sent Y Received

Byles FAFE 5342
Compeassian: 0% o
Eirarz 1] 0
PIDpEIliESJ l Diisconnect ]

Please click on the [Disconnect] button when you want to disconnect from the Internet.

Alternatively, please right-click on the\gicon, and then click on [Disconnect].

Cisconnesct
Status

Crpan Nebweork Connections

Ol B

Note
- You can start an application to make an automatic connection to the Internet, but

you can also make a manual connection using the connection destination icon.
The procedure is described below.

1. From the [Bluetooth Settings] window, right-click on the connection
destination icon, and then click on [Connect] from the menu that appears.

31



[ &’ Bluetooth Settings B 31 <

Bluetooth  WView Help

£) Bluetooth

A window indicating that the connection is being established will appear.

@|;I|:.-r-...|:r.'1.-|||.-.--. il L L_\.r

If the connection has been established successfully, the connection icon and task
tray will appear as shown below.

j; London A is now connected |

Spead: 115.2 Kbps

SO P uQO 1 o2

You will be able to browse Web pages using your browser and send and receive
e-mail.
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Important
- Please enter the e-mail settings separately if you are going to use e-mail (the
set-up method will vary with the application).

2. End the connection
Right-click on the icon, and then click [Disconnect] to end the connection.

| & Bluetooth Settings = <)
Bhetooth View Help

£3 Bluetooth

Dilabe

Detal. .,

Create Shortcut on Deskiop
| ————— Rename
Change Icons...

Ew._..l..] 74 Delata

New
Connection

The following message will appear. Click on the [Yes] button.

‘Bluetooth Settings

b d London & cannot be used If disconnected.
-!r) Are wou sire you want ko disconnect?

[T (| p——

When the icon appears as shown below, the connection will have ended.
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41.2 Connecting to the internet using a mobile telephone

Important

- In order to connect to the Internet, you must have already signed up with a
provider and obtained a connection ID and password. Please ensure you have
confirmed the ID, password and telephone number of your provider's access
point before you begin the set-up process.

- A Bluetooth passkey (PIN code) is required for you to connect to the mobile
telephone. Please make a note of your Bluetooth passkey before you start the
set-up process.

Configuring a mobile telephone for use a modem
1. Turn on the mobile phone, and set it to be connectable via Bluetooth.

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New
Connection].

Bluetooth Settings

Add MNew Conmection
Diesace Properties

Paiwer OFF

Ciplions b

Hedp
Exit

. ¥ Q&

Note
- Alternatively, click [Start]—[All Programs]—[Bluetooth]—[Bluetooth Settings],
and then click on [New Connection] from the active [Bluetooth Settings] window.

3. Confirm that [Express Mode] has been selected, and then click on the [Next]
button.
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r'l.dd Hew Connection Wizard

Thiz wizard will create the zettings for Bluetooth device connection.

Pleass ensure pour Blustooth devices are on and zet to
dizcoverable.

(%) Expuess Moda [Recommended

() Cugtom Mode
Thiz: alloves pou to set the detals for the cormechion.

rere | |- ]

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will
appear.

"l.dd Hew Connection Wizard

Searching for Bluetooth devices.

Seaiching for Bluetooth devices.

4. Select the device name of the mobile telephone from [Device List], and then
click on the [Next] button.
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T Tow Connaction Wizard

Select a device

Pleass choose the Bhastooth desvice you wish bo use.

Blustooth device

Drevica Mame

PocketPC:
£ Bletaoth Printer

|_ + Back ][_ﬂaan ][ LCancal ]

The [Add New Connection Wizard (Searching for Services)] window will appear.

r'|l|n|1:|1 Hew Connection Wizard

Pleaze wait while the wizard connect: to a remote device.

The local device iz connecting lo the iemate device
ZAMVICE,
Pleaze wail

Once a service has been detected successfully, connection to the device and COM
port creation will be performed automatically, after which the [Add New Connection
Wizard (Modem Settings)] window will appear.

. If you are connecting to a mobile telephone for the first time, enter the
passkey for the wireless modem station under [Bluetooth Passkey (PIN
code)], and then click on the [OK] button.
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‘Bluetooth Manager - Bluetooth Security

Blustooth Passkey [FINL Ty
ﬁ% {1Flett blarik, the default PIN will be used )
Request Device

Elustooth Device Addiess.  D0;00:00:00:00;00
Bluetooth Device Mamea; TOSHIES BT Modem

[ ok ][ cona ]

Once the program has finished searching for the devices, the [Add New
Connection Wizard (Device Selection)] window will appear.

6. Click on the [Next] button.

tﬁdd Hew Connection Wizard

Advanced Modem Setlings

Fleasze chok the “advanced Modem Settings”” button
fiee Purther conhiguestion options (&0, lar HSCSD o
GPRS] or click “Hext" o contines.

| Schvanced Modem Setlings... |

f<Back | Mews || Cacal |

Certain modems require you to configure initialization commands separately.
Please click on the [Additional initialization Command Settings] button, enter the
initialization commands in the following window, and then click on the [OK]
button.
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‘Advanced Modem Settings E

‘fou can anbar gpecial AT-Commands fos the mstalled modem. This
may be necessany fod some connections. &.9. GFRS and HSCSD

Flease check the homepage of your provider and your mobil phone
vendor io gel the coinect setings. These seltmgs wall vary betwesn
differant mobide phoess vendors and prowiders.

Examples:

GFRS5: +I:.EEI-|I|-HT =1,"IP" "apn.provider. de™
HSCSD: «CBST=81.0,1:+CHSN-4.0.0.0

Estra inkializabion commands:

[ ok | [ Cancel |

7. Enter the connection name (optional), telephone number (of your provider's
access point), user name and password (as issued by your provider), and
then click on the [Finish] button.

r‘“dd Haew Connection Wizard

Create dial-up connection

Please give the dislup connechon a name, telephone
number, and ¥ requited, 3 wuser name and password

Dialup connection name: || andon 4

Telephone nurmber, (207 957 6543
Lo Flewnes igoody 53
Pagsmand: ssEsEsns e
Confiom password: LTI TTTITT Y
[#] Set s Defaut Diskup
[ <Back ]| Finish | [ Cancel |

Important
- The sample entries shown in the window are provided solely for purpose of

explanation. Please use your own telephone number, ID and password
according to the arrangement with your provider.

The settings will be registered, and an icon will appear in the [Bluetooth Settings]
window.
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London &

Connecting to the Internet
1. Start your browser, e-mail application or other application

Important
- Please enter the e-mail settings separately if you are going to use e-mail (the
set-up method will vary with the application).

2. Enter the URL of the Web page you wish to display and then press the [Enter]
key, or use the e-mail tool to send/receive items or perform other activities.

The [Dial-up Connection] window will appear.

3. Click on the [Connect] button

Dial-up Connection ﬁ
M- Select the sesvice wou want bo connect
ﬂ to, and then entes pour user nams and
passward,
Copnecltoc  |London & ™
Llser name: rgocdy @9
Passweed SEEESSEEESRENNAN
[+#] S ave pazsword

[]Connect automaticaly

[_Connect | | Settings.. | [ Wicek Qffine |

Important
- A connection will be automatically established with the modem station if COM

Auto Connect is available. If COM Auto Connect is not available, please
manually connect to the mobile telephone .

The following message will appear once you have connected to the Internet.

I,., London & is now connected -

Spead: 115.2 Ebps
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4. End the connection

The window below will appear if you double-click on the:yicon in the task bar.

i London A Status L:’_]
Germral | Dietails

Conneclion
Staluz: Conreched
Diuratian; 00006
Speed 1152 Kbps

Acinaly

— N — ;
Sent Y Received

Byles FAFE 5342
Compeassian: 0% o
Eirarz 1] 0
PIDpEIliESJ l Diisconnect ]

Please click on the [Disconnect] button when you want to disconnect from the Internet.

Alternatively, please right-click on the\gicon, and then click on [Disconnect].

Cisconnesct
Status

Crpan Nebweork Connections

Ol B

Note
- You can start an application to make an automatic connection to the Internet, but

you can also make a manual connection using the connection destination icon.
The procedure is described below.

1. From the [Bluetooth Settings] window, right-click on the connection
destination icon, and then click on [Connect] from the menu that appears.
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[ &’ Bluetooth Settings B 31 <

Bluetooth  WView Help

£) Bluetooth

A window indicating that the connection is being established will appear.

@|;I|:.-r-...|:r.'1.-|||.-.--. il L L_\.r

If the connection has been established successfully, the connection icon and task
tray will appear as shown below.

j; London A is now connected |

Spead: 115.2 Kbps

SO P uQO 1 o2

You will be able to browse Web pages using your browser and send and receive
e-mail.
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Important
- Please enter the e-mail settings separately if you are going to use e-mail (the
set-up method will vary with the application).

2. End the connection
Right-click on the icon, and then click [Disconnect] to end the connection.

| & Bluetooth Settings = <)
Bhetooth View Help

£3 Bluetooth

Dilabe

Detal. .,

Create Shortcut on Deskiop
| ————— Rename
Change Icons...

Ew._..l..] 74 Delata

New
Connection

The following message will appear. Click on the [Yes] button.

‘Bluetooth Settings

b d London & cannot be used If disconnected.
-!r) Are wou sire you want ko disconnect?

[T (| p——

When the icon appears as shown below, the connection will have ended.
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4.2 Connecting to a network[LAN]
4.2.1 Connecting to a LAN using an access point[LAP]
Setting up the access point

Important

- The access point must have been started and a normal connection already
established to the network before the access point is set up. Please refer to the
access point instruction manual for information on how to set up the access
point.

- A Bluetooth passkey (PIN code) is required for you to connect to the access
point. Please make a note of your Bluetooth passkey before you start the set-up
process.

1. Turn on the access point, and confirm that a connection has been
established with the network.

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New
Connection].

Bluetooth Settings

Add MNew Conmection
Diesace Properties

Paiwer OFF

Ciplions b

Hedp
Exit

. ¥ Q&

Note
- Alternatively, click [Start]—[All Programs]—[Bluetooth]—[Bluetooth Settings],
and then click on [New Connection] from the active [Bluetooth Settings] window.

3. Confirm that [Express Mode] has been selected, and then click on the [Next]
button.
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";I.dd Hew Connection Wizard

Thiz wizard will create the zettings for Bluetooth device connection.

Pleass ensure pour Blustooth devices are on and zet to
dizcoverable.

(%) Expuess Moda [Recommended

() Cugtom Mode
Thiz: alloves pou to set the detals for the cormechion.

rere | |- ]

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will
appear.

";I.dd Hew Connection Wizard

Searching for Bluetooth devices.

Seaiching for Bluetooth devices.

'

4. Select the device name of the access point from [Device List], and then click
on the [Next] button.




Add New Connection Wizard

Select a device

Pleass choose the Bhestooth device you wish bo use.

Blugiooth device addiess

Device list
Device Hame Device Addiess el
& gt |
PCA 00:03: 74066483
[¥]
[ ¢Back || Mew> | [ Cancal |

You will be asked for the Bluetooth passkey in the window that appears.

5. Enter the passkey under [Bluetooth Passkey (PIN code)], and then click on
the [OK] button.

Bluetooth Manager - Bluetooth Security

Blustocth Passkey (PIN} vee
% {Ffeft blarik, the default PIN wil be used )
Requeast Devies
Elustooth Devies Addiess; 0003 7A02C587
Bluetooth Devica Mamea; BT-AP

[ ok ][ conce ]

Service detection and COM port creation will be performed automatically.
The [Add New Connection Wizard (Create Connection Destination)] window will
appear.

6. Enter the connection name, user name and password, then click on the
[Next] button.
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Add Mew Connection Wizard

Create a connection setting

Flease give the conmeclion a name, and if required, a user
natne and passward

Conneclion name: Diect Cormeclion
Uzar nanme:
Pazsword:

Confiom password:

| <Back || Mew> | [ Cancel |

Note
- The user name and password are entered here to allow you to connect to the
access point.

The [Add New Connection Wizard (Confirm Dial-up Settings)] window will appear.

7. Click on the [Confirm Settings] button.

Add New Connection Wizard

Pleaze confitm a dial-up zetting

If [Mewver dial a connection] has been selected n the
Intemet propesties, connections made according lo the
COM Autoconnact setlings will ot lunction properk.
Flease press the button below o conlim disl-up seltings,

Conhim sathings... ]

| <Back || Mews | [ Cancel |

8. Configure the connection method, and then click on the [OK] button.
Set the connection destination used for the LAN connection set up in (6) above as
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the default connection destination, and then select "Always dial my default
connection."

~

i T a

| Gererdl | Secuwily | Privacy | Cl:lrﬁurﬁ: Connections | Pragrams | Advanced |

g' = Toset up an Inbernat connection, chck
B set,
Dralup and Virtual Pivate Metwork settings
58 Direct Connection [Defaul]

Etup.

Choge Sattings if you nesd to configure & preocy Settings...
sarver For a connection.

() Neves dial a conneclion

() Dial whenever a network connection is not prasert
@ Blways dial my defoult connection

Currant Direxct Connection

Local drea Metwork [LAN) setlings

LAN Settings do not spply to did-up connedtions. LAM Sattings...
Choose Sattings above For dial-up settings,

[ ok [ cance |[ ek |

9. Click on the [Next] button.

Add Hew Connection Wizard

Pleaze confitm a dial-up setting

I [Meswver dial a connechion] has been zelected n the
Intemet propesties, connections made according 1o the
COM Autoconnect settings will not function proparky.
Please piess the butlon below lo conlirm disl-up sellings.

Confim zathings... ]

| <Back || Net> 1§ | Cancel |

10. Enter the type and name of the icon displayed after registration, and then
click on the [Next] button.
Please click on the [Next] button if you are satisfied with the settings.
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Add New Connection Wizard

Enter a name and zelect an icon.

Setup the conmechon name and icon.

Sethng infomnation
Connection Mame:
BT-AP1[192 162.100.11] [Direct Connection]

lcon
% | Change lconz... |

[ ] Cieste a shatteut an the deskiop

[ <Back || Mewt> | [ Cancel ]

11. Click on the [Finish] button.

The access point icon will be registered in the [Bluetooth Settings] window.

X

BT-AP-1{152.1
£8.100.11)
[Cirect

Connection]
Connecting to a LAN(LAP)

1. Right-click on the connection icon in the [Bluetooth Settings] window, and
then click on [Connect].

L2 Bluetooth Settings ==
Bhetooth  View Help
; £3 Bluetooth
H -
e
BT-AP-1(1%
66,1001 Connect
[Direct
Connectic
Delata
Create Shorbout on Deskbop
L Fenams
Thange loons. ..
Hom = | 7§ Delata
Connection
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2. Confirm that "Direct connection" has been selected under [Connection
Destination], and then click on the [Connect] button

Mal-up Connection
- Select the service pou want bo connexct
:_mii b, ard then erted pour user nams and
pazswoid,
Connect bo Direct Connection bl
Llzar name:
Passwoad
[15ave pazsword
| Lonnect [ Setlings... j l Canceal ]

A connection will be initiated.

Note

- This is an example of what happens when you use "Direct connection" as a
connection name under "Connect to access point." If a name different from the
connection name is used, that name will appear under [Connection
Destination].

- Please simply click on [Settings] if no user name or password have been
entered (i.e., if those fields have been left blank)

- Please change the connection destination if a different connection name (for a
dial-up connection) appears in [Connection Destination].

Direct Connaction w |

t Connection |
Lonmdan &

Once you connect to the network, Internet Explorer will start automatically, and you
will be able to exchange data with other computers on the network.

Note
- Please follow the procedure below if you need to set up a proxy server to
connect to the Internet (the following procedure is not necessary if the PC you
are going to use has already been set up as a proxy server).

1. Select [Internet Options...] from the [Tools] menu in Internet Explorer.

The [Internet Options] window will appear.
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2. Click on the [Connections] tab, and then click on the [Settings...]
button.

Internet Properties e
| | General | Secuily | Privacy | Cordent | Connections | Programs | Advanced|

. Toset up an Inbermeat connection, chck _
‘g I"'F' i Setup
Dralup and Virual Prvate Metwork setings

|

| & London A

Choose Settings f you needito corfigure 3proxy | Gattings . |
server for a connechion. &

() Neves dial a connechion

() Dial whernever a retwork connection is not prazert
(3 Blways dial my defaull connection

Current Direct Conmection

Local duea Metwork |LAM] setlings

LAN Settings da not apply to dis-up connedtians. Settings...
Chicose Sattings above For dial-up settings, LK

[_oc [ concst J[ soow |

3. Enter the IP address and port number of the proxy server under [Proxy
Server], and then click on the [OK] button.

f)ﬁilmcﬁ“mﬁﬁa'ﬂﬁ# frasbiai b T T - EE\

Automatic configuration

Autcanatic configuration may owerride manwal settings. To ensura the
use of marasal settings, dissble sutomatic configuration,

[ sutomatically detect settings
[[JUse aubomatic confiquration soipk

Prosy server

Ll:sea progy server for this connection {Thesa sattings will mok
apply to obher connections),

Address:  172.17.40.100  Porf: | 80 Advanged..,
[[J&vpass proxy seever For local addresses

Dial-up settings

LUser nanme: Properties
Password: |
Dicenain;

oo | [ cancei ]




4.2.2 Connecting to a LAN using an access point[PAN]
Setting up the access point

Important

- The access point must have been started and a normal connection already
established to the network before the access point is set up. Please refer to the
access point instruction manual for information on how to set up the access
point.

- A Bluetooth passkey (PIN code) is required for you to connect to the access
point. Please make a note of your Bluetooth passkey before you start the set-up
process.

2. Turn on the access point, and confirm that a connection has been
established with the network.

3. Right-click the Bluetooth icon in the task tray, and then click on [Add New
Connection].

Bluetooth Settings

Add MNew Conmection
Diesace Properties

Paiwer OFF

Ciplions b

Hedp
Exit

. ¥ Q&

Note
- Alternatively, click [Start]—[All Programs]—[Bluetooth]—[Bluetooth Settings],
and then click on [New Connection] from the active [Bluetooth Settings] window.

4. Confirm that [Express Mode] has been selected, and then click on the [Next]
button.
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";I.dd Hew Connection Wizard

Thiz wizard will create the zettings for Bluetooth device connection.

Pleass ensure pour Blustooth devices are on and zet to
dizcoverable.

(%) Expuess Moda [Recommended

() Cugtom Mode
Thiz: alloves pou to set the detals for the cormechion.

rere | |- ]

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will
appear.

";I.dd Hew Connection Wizard

Searching for Bluetooth devices.

Seaiching for Bluetooth devices.

'

5. Select the device name of the access point from [Device List], and then click
on the [Next] button.

52



Add New Connection Wizard

Select a device

Pleass choose the Blustooth device you vazh bo use.

Bluetooth device addiess

Dievice kst
Dewice Mame Device Addiess -'*
[BT-8P1 [V (1= o o o T A

W

| <Back || Mews> | [ Cancel |

You will be asked for the Bluetooth passkey in the window that appears.

6. Enter the passkey under [Bluetooth Passkey (PIN code)], and then click on
the [OK] button.

Bluetooth Manager - Bluetooth Security

Bluetocth Passkey [PIN}
% [IF Iedt blarsk., the default PIN will be used |
Request Devics
Elustooth Devies Addiess:  00:40:8C:5C:BC.E87
Bluetooth Davice Mamsa: BT-AP-1  [192163.100.21)

[ ok ][ caca |

Service detection and COM port creation will be performed automatically.
The [Add New Connection Wizard (Connection Name Settings)] window will
appear.

7. Enter the type and name of the icon displayed after registration, and then
click on the [Next] button.
Please click on the [Next] button if you are satisfied with the settings.
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Add New Connection Wizard

Enter a name and select an icon.

Setup the cormecton name and icon.

Setbng infomation
Connection Mame:

BT-AP-i  [19216210021)

% | Change leons...

[ ] Cieate & shatteut an the deskiop

| <Back || Mews> | [ Cancel |

The [Add New Connection Wizard (Completing the Add New Connection Wizard)]
window will appear.

8. Click on the [Finish] button.
The access point icon will be registered in the [Bluetooth Settings] window.

]

H =
i BT-AP-1
19216801723

This will complete the access point set-up process.
Connecting to a LAN(PAN)

1. Right-click on the connection icon in the [Bluetooth Settings] window, and
then click on [Connect].
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! Bluetooth Settings T;.I[_D_]ﬁ
Bhetooth  View Halp

£3 Bluetooth

Connect

Delata
Dietal. ..

Create Shortout on Deskbop
L PRename
Thange Ioons. ..

o Hom =1 | 7§ Delate
P4 Cannection

2. Enter the passkey under [Bluetooth Passkey (PIN code)], and then click on
the [OK] button.

Bluetooth Manager - Bluetooth Security

Bluetocth Passkey [PIN}
% {IF left blanik, the default PIN will be used )
Request Device
Elustooth Device dddiess: 004080508087
Bluetooth Deavice Mame: BT-AP-1  [192163.100.21)

[ ok | [ canca |

A connection will be initiated.

Note
- Please follow the procedure below if you need to set up a proxy server to
connect to the Internet (the following procedure is not necessary if the PC you
are going to use has already been set up as a proxy server).

1. Select [Internet Options...] from the [Tools] menu in Internet Explorer.
The [Internet Options] window will appear.

2. Click on the [Connections] tab, and then click on the [Settings...]
button.




Internet Properties 2
| General | Secuity | Privacy | Content | Connections | Programs | Advanced|

= Toset up an Inbermat conniection, chck _
"5 : I"'F' ; Setup...

Dralup and Virual Prvate Metwork settings

58 Direct Connection [Defaut] [ agd

Lendon & |

Cheose Sattings if you need to canfigure & proy _ ettings..
server for a connection. &

() Neves dial a conneclion

() Dial whenever a network connection is not prasert
(2 Always dial my defeull connection

Currant Direct Connection

Local drea Metwork |LAN] setlings

LAN Settings da not spply to dishup connedtians. Saltings...
Choose Sattings above For dial-up settings, LK

[_ox [ concest J[ aeow |

3. Enter the IP address and port number of the proxy server under [Proxy
Server], and then click on the [OK] button.

Local Area Network (LAN) Settings 2JEd
Automatic configuration

Automatic configuration may override manal settings. To ensure the
use of marual settings, disable sutcmatic configur ation,

[ twsbomaticaltr datact sebtings
[ Use aukomatic configuration scripk

Address

Prioiiy Sarver

Ll:sca proey server for vour LAN (These settings wil not apphy to
dial-up or ¥PN conmections).

Address:  172.17.40.100  Pork: | 80 r————
[ ] Bypass procey server for local addresses

[ o ][ caca |




4.3 Sending files

You can send and receive files other than business card data with a Bluetooth-enabled
PC or PDA.

Use "File transfer" in the Bluetooth Information Exchanger to exchange files.

Note

- The same operations will be valid as long as the PC and PDA support the FTP
profile

- "File transfer" cannot be used to send or receive business card data. Please
instead use "Object Push" to perform these activities.

4.3.1 Exchanging files with a PC or PDA
Sending files to a PC or PDA
1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

[{{Tm

Bluetookh
Information
Exchanger

Note

- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.
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Flle View Favorites Tools  Blustooth  Help o
Qs - © - (F O sech | v | [ [ (2 Ao
b 1Ry
f_z} Desktop '
# =) My Doouments File Tramsfer  Image  Object Push

Transfer

B Q My Computer
H g My Network Places
& Recycl Bin
& ¥1¥ Bluetooth Infarmation Exchanger
# B3 File Transfer
® 9 Image Transfer
i G object Push

3. Double-click on the [File transfer] icon.

A list of devices will appear in the [File transfer] window.

T3 File Transfer B = <
Efe  Wew Favorbes Tooks  Bustooth  Hel I
@Eﬂ v s ? ,..f: Search it Folders ;EIG D
Agdress Ig Blustooth Infarmation ExchangeriFike Transfar ""] Go
Shared Folder PC-1 POA-1 POA-2
Note

- If the desired device does not appear in the list, please confirm that the device
has been turned on, and then select [Bluetooth]—[Search Devices].
A device search will be performed.

- You can also use "Image transfer" when sending individual image files.




4. Use the mouse to drag and drop the file you wish to send over the destination

icon.
In this case, the file will be sent to a PC named "PC-1".

B = B

Shared Folder pe-x PO-1
=1
Xy
"
-
Fle-1bt] Fila-2 ot
Note
- When using "File transfer", you can send individual files as well as entire
folders.

5. Confirm that the file is being sent.
The file will be sent to the PC.

Note
- When sending files using "File transfer", a message requesting permission to
receive the files may appear on the destination (receiving) device. The content of
the message will vary with the Bluetooth software installed on the destination
device, so please be sure to follow the instructions provided.
If you are using the Bluetooth Utility, a message similar to the one below will
appear.

File Receive Confirmation

Do wou allow a Connect Beguest irom 00:03:2F:04:BAF3?

Save Folder
C:ADacuments and Setlings A dminstrstarby Documen:

ook | [ cacel |

If the file has been sent successfully, the message below will appear.
Please click on the [OK] button.




Bluetooth E

-
\"‘"-'I') Filie bransfer was successhul.

The message below will appear if the file transmission was unsuccessful.
Please click on the [OK] button to close the message, and repeat the procedure.

Note
- Files that have been sent will be saved in a file transfer shared folder on the
destination device.
- Additionally, with "File transfer", you can open the shared folder on the

destination device using Explorer, specify a subfolder, and then send the file
there.

1 Personal '-I[:.I;‘J

=

Fle ‘iew Fawvoribes Tools  Suetoocth  Help o
Qe - ©  F O sewch [ roces | [ [ (=
Friders = :‘E ':'_'

|_:} Desktop ~
# ) My Documenks Folder-| File-1 bxt
@ Yty Computer
# &g My Network Places
= Recycke Bin
= ¥[* Bluetooth Information Exchanger
= 2 File Transfer
% ) shared Folder
= & row-1
% [ Business
= ‘Y Personal
# 1 Falder-1
# 1 Templates
[+ *& Image Transfer
# O Object Push =

- You can use Properties in the Bluetooth Information Exchanger to change the
location of the "Shared folder" on the hard drive.

Receiving files from a PC or PDA




Your PC is able to receive files that have been saved in the shared folder on the
destination PC or PDA. Received files will be saved in the shared folder under "File

transfer".

1. Turn on the PC or PDA.

Confirm that a Bluetooth connection has been enabled before proceeding.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

Note

- Alternatively, opening Explorer and clicking on the Bluetooth Information

Exchanger folder will produce the same result.

L7 Bluetooth Information Exc hanger

BEX]

Bz ‘Wew Favoribes Tools Buetooth Help

Address

Qe - ) - (T ) seah :u:_' rlders E = [ (=
Fobders = % é% lE

I-'-‘} Desktop
© {7} #y Doouments File Transfer Image Cibject Push
Transher

& 5 My Computer
B ‘3 My Network Places
& Recyde Bin
B ¥ Buetooth Infarmation Exdhanger
B % File Transfer
[ % Image Transfer
B % Objgect Push

3. Double-click on the [File transfer] icon

A list of devices will appear in the [File transfer] window.
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(23 Fite Transfer =J2/Ed
Ele Wew Faworbes Tools  Buetooth  Help T
@ Back » g ? P, Search || Folders EI Ej m D
Addrass % Bluetooth Information Exchanger|Fie Transfer ﬂ Go

B A § N
Shared Folder PC-1 FOR-1 FODA-2

In this case, the file will be received from the PDA named "My Mobile".

4. Double-click on the [PDA-1] icon
The file saved in the shared folder in "My Mobile" will appear.

5. Right-click on the file you wish to receive, and then select "Receive file".

I";_.'i Personal g@-l

Fle View Favorbes Tools Bluetooth Help

@Ba-:k - s ? f: ! Search Folders IEE E
— % !
Frldar-1 File-1,txt

L] B
Recene Fila
Delete

The file will be received from a PDA.

Note
- With "File transfer", you can send individual files as well as entire folders.
Please right-click on the folder you wish to receive, and select "Receive folder".
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Qe - Q- ¥ J

Foldar-1 File-1.txt
Open

Explarer

Subsequent operations should be performed in the same manner as when
receiving individual files.

If the file has been received successfully, the message below will appear.
Please click on the [OK] button.

The message below will appear if the file transmission was unsuccessful. Please
click on the [OK] button to close the message, and repeat the procedure.

Bluetoath =

g Sending of file Fallad.

Note
- The received file will be saved in the "Shared folder" under "File transfer" in the

Bluetooth Information Exchanger
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H :-::. Trmage Transfer
& B obiect Push

w4

You can use Properties under the Bluetooth Information Exchanger to specify
the location of the "Shared folder" on the hard drive.

4.3.2 Sending images to a mobile telephone

1. Turn on the PC or PDA.

Double-click on the Bluetooth Information Exchanger icon on the Desktop.

((te))

Bluetanth
Information
Exchanger

Note

- The mobile telephone must support the BIP profile.

- The image file”’(*.bmp)(*.jpg,*.jpeg)(*.png)” formats can be sent and received
using "Image transfer".

- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.
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7 Bluetooth Information Exchanger L.Jw

Fle Vew Favortes Toos  Bustooth  Help ar
Qui- © 3 Osowr [pros | EE @ E s
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= ¥1¥ Bluetooth Information Exchanger
# B3 File Transfer
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3. Double-click on the [File transfer] icon.
A list of devices will appear in the [File transfer] window.

T2 File Transfer 18 =1}
Ee  Wew Favoribes Jools  Euetooth  Help aE
@M - ~.._p1 ? inum:h it ' Folders Ei|. - .

Addres %E&Jat%]nﬁmﬂmh:h&r}arfhﬂmsfer \ﬂ = =
PC-1 POA-1 PDA-2

4. Drag and drop the file you wish to send over the destination icon.
In this case, the image will be sent to a mobile telephone named "BT-Phone-1".




r-.
&-hl:--:-' Iranster |l

@mk -~ & . ; ‘,'.‘Ecmh | Folders |E]|E r_':‘j D
G !

Image InBox  BT-Camers-1  BT-Ph

The image will be sent.
If the image has been sent successfully, the message below will appear.
Please click on the [OK] button.

Bluetooth |

\jl') Image bransfer was sucoessful.

The message below will appear if the image transmission was unsuccessful.
Please click on the [OK] button to close the message, and repeat the procedure.

‘Bluetooth B

JB Sending of image Failed.




4.4 Exchanging business card data with a PC or PDA

You can exchange business card data with a Bluetooth-enabled PC or PDA.

Business card data are exchanged using "Object Push" under Bluetooth Information
Exchanger.

Selecting a business card and sending it to a PC or PDA

1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

Note

- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.

. —r— 5

f Bluetooth Information Exchanger L.:',..-LI:_J.]
Fle View Favorbes Tooks  Blustocth  Help H
@Ba-:k > i F P ! Search |:_' Folders E m r:{:] D Address
TR 3

I-'-‘} Desktop

# () My Dooumenks File Transfer Image Chject Push

3 .‘j’ My Compiter Transfer

% W My Netwark Blaces
# Recydle Bin
B ¥ Buetooth Infarmation Exdhanger
I+ I\-t"% File: Transfer
[ % Image Transfer
B8 object Push

3. Double-click on the [Object Push] icon.
A list of devices will appear in the [Object Push] window.
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L4 Object Push k3
Fie Yiew Favorbes Tools  Blustooth  Help "
{}Emk * & ﬁ 2 Search || Foldess El j [E Ij

m H |8
Inbie P-1 PLa-1

Note
- If the desired device does not appear in the list, please confirm that the device

has been turned on, and then select [Bluetooth]—[Search Devices].
A device search will be performed.

4. Use the mouse to drag and drop the business card you wish to send over the

destination icon
In this case, the business card will be sent to a PC named "PC-1".

ek - €) - ) ) search [ Folders E|3|:|

his

Note
- When you try to send a business card, a message requesting permission to
receive the card may appear on the device belonging to the other party (i.e., on
the receiving end). The content of the message will vary with the Bluetooth
software installed on the destination device, so please be sure to follow the
instructions provided. If you are using the Bluetooth Utility, a message similar to
the one below will appear.




File Receive Confirmation

Do pou wiank bo receive a Business Card from D0:003: TA:02.CR877

Save Folder
CA\Dacurnents and Setlings'\AdmmshstarMy Dacument:

Co ] o)

If the business card has been sent successfully, the message below will appear.
Please click on the [OK] button.

Bluetooth

-
""'ll) Business Card transfer was suocesshul,

The message below will appear if the business card transmission was

unsuccessful.
Please click on the [OK] button to close the message, and repeat the procedure.

Blustooth E

!‘_\ Sending of Business Card Failed.

Selecting your personal business card

You can prepare a business card bearing your name and other details such as your
company and telephone numbers, and then send it to another party.

Note
- Alternatively, opening Explorer and clicking on the Bluetooth Information

Exchanger folder will produce the same result.

1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

((te))

Eluetoath
Information
E:xchanger




Note

- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.

Jﬂluetqnthlrrfmmatmn [m:h,ange[ ...................................... g@
Efa  Weew Favorites  Tools  Bluetookth Hsh

Back ~ 0 ! Search | ~ Folders | Address
= ? F |

Folders

R t@ % o

5 5 My b enks File Transfer TIrr-au-: Object Push
& W My Computer FRIEERE,

& \3 My Network Places
& Recyde Bin
= ¥1¥ Bluetooth Infarmation Exchanger
i B File Transfer
® =y Image Transfer
% 3 object Push

3. Double-click on the [Object Push] icon.
A list of devices will appear in the [Object Push] window.

Ebe ‘Wew Favonbes Jools Blustooth  Help

T4 Object Push SEE
Ay
L]

@Eﬁ:k" i ? {.'Scar:h | Folders E|E|D

= B §

Inbaoe PCa-1

Note

- If the desired device does not appear in the list, please confirm that the device

has been turned on, and then select [Bluetooth]—[Search Devices].
A device search will be performed.

70



4. Right-click on the destination icon, and then click on [Send business card
Tol.
In this case, your personal business card will be sent to a PC named "PC-1".

(2 Object Push i._:-j[ﬁl
Fle ‘Views Favorites Tools Bluetooth  Help iff

Qui- O ¥ Psewer i roter |[3]FT (71 (3

m = 5

Inbe PC-1 Do
Open

Explarer

Praperty
Delate
Service Disoovery

Send Business Card To
Receive Partner's Business Card From
Exchange Py Business Card

The business card will be sent.

Note
- When you try to send a business card, a message requesting permission to
receive the files may appear on the device belonging to the other party (i.e., on
the receiving end). The content of the message will vary with the Bluetooth
software installed on the destination device, so please be sure to follow the
instructions provided. If you are using the Bluetooth Utility, a message similar to
the one below will appear.

Blustooth

_\,.:_/ Wil you aliow a Business Card transfer bo 00:053: 7A:02:C9:577

e
|
f
u_...;
o
%

- Business cards that have been sent will be saved in the Inbox of the destination
party.

If your business card has been sent successfully, the message below will appear.
Please click on the [OK] button.

4



Bluetooth

» 1
llj Business Card transfer was successhiul,
L

The message below will appear if the business card transmission was unsuccessful.
Please click on the [OK] button to close the message, and repeat the procedure.

Blueteoth ﬁ
!"-'. Sending of Business Card Failed.

Note
- Data that has been sent will be saved in a folder for exchanged business cards
on the destination device.

Receiving a business card from another party

You can prepare a business card bearing your name and other details such as your
company and telephone numbers, and then send it to another party.

Note
- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.

1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

()

Blustaokh
Information
Exchanger

Note
- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.
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Flle View Favorites Tools  Blustooth  Help b

Qe+ Q) - (B O sewch [ rodes | [5]|[5] (1] (] ufress
5 o 1B B -
|_-_»} Desktop
# () My Dooumenks File Transfer TIrnage Object Push
® ',j! My Computer Transfer
H g My Network Places
# Recycl Bin

5 ¥ Bluezooth Information Exchanger
H % File: Transfer
® % Image Transfer
H 'E, Obgect Push

3. Double-click on the [Object Push] icon.
A list of devices will appear in the [Object Push] window.

U5 Object Push =%

Eda ‘Mew Favorbes Tools Bluetooth Help 'lil-
@Bﬁ"k" ad > ] - Search || = Folders =] G =

= B 8

Inbiox PC-1 PDA-1

Note

- If the desired device does not appear in the list, please confirm that the device

has been turned on, and then select [Bluetooth]—[Search Devices].
A device search will be performed.

4. Right-click on the icon of the party whose card you wish to acquire, and then
click on [Receive business card]

In this case, the business card of the other party will be acquired from a PC named
"PC-1".
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Exchange My Business Card

The business card will be received.
Exchanging business cards
Simultaneously exchange your business card with one belonging to another party.
1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

(((#))

Note
- Alternatively, opening Explorer and clicking on the Bluetooth Information
Exchanger folder will produce the same result.
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3. Double-click on the [Object Push] icon.
A list of devices will appear in the [Object Push] window.

U5 Object Push =%

Eda ‘Mew Favorbes Tools Bluetooth Help 'lil-
@Bﬁ"k" ad > ] - Search || = Folders =] G =

= B 8

Inbiox PC-1 PDA-1

Note

- If the desired device does not appear in the list, please confirm that the device

has been turned on, and then select [Bluetooth]—[Search Devices].
A device search will be performed.

4. Right-click on the icon of the party with whom you wish to exchange
business cards, and then click on [Object Push].

In this case, the business cards will be exchanged with a PC named "PC-1".
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The business card from the party who executed the "Exchange business cards"
command will be sent first.

Note

- When you try to send a business card, a message requesting permission to
receive the files may appear on the device belonging to the other party (i.e., on the
receiving end). The content of the message will vary with the Bluetooth software
installed on the destination device, so please be sure to follow the instructions
provided.

If you are using the Bluetooth Utility, a message similar to the one below will
appear.

File Receive Confirmation

Do s wank b receive a Business Cad fuom 0000k 74c02:C:877

Save Folder
CADocuments and Setlings'\Adminstestornby Document:

o) o
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4.5 Synchronizing data with a PDA

When you connect via Bluetooth instead of with a standard cable, you will always be able
to synchronize your data without the hassle of having to connect the cable.

4.5.1 Connecting using ActiveSync
Preparing the PC
1. On the PC, click on [Start]2>[All Programs]—=>[Microsoft ActiveSync].
The initial ActiveSync set-up window will appear.

It is assumed in the explanation below that no ActiveSync connections have been
established with other devices.

& Microsoft ActiveSync g
Fie Yiew Tools Help .

Detals

No partnerships
4+
Mol connected @

Information Type Status

2. Click [File]>[Connection Settings].

& Microsoft ActiveSync H '
|Fle View Tools Help

b 2

é (¥
Get Connected.. I
Connaction Sektings. ., E
Close 3
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The [Connection Settings] window will appear.

3. Place a check next to [Allow serial cable or infrared connection to this COM
port], and then select "COM7".

Connection Settings ﬁ

= Click Get Connected to connect your mobile device b this
Ly comeuter

Shatus: 'Wating fos device bo connect Get Conneched..

¥ Allove genial cable o infraned connection to this COM poit:

LOM7 K
Status: DO pod i not available

W Allovs USE connection with this desktop computes.
Stabs;  USE is avalable

¥ Allow pebwork (Ethemet] and Femote Access Service [FAS)
zapal cohhechion with this desklop compiter

Stabe;  Metwork i avalable

Shalus icom
[ Show stabus jcon in Taskbar,

[ ok | caxe | Hep

Note
- In the standard set-up, the port is configured to "COM7" (refer to Steps (3) and

(4) under "Preparing the PDA" below). When using a different port, please also
change the port number selected in this window

Preparing the PDA

1. Tap on the Bluetooth icon in the bottom right of the screen.
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(3 Tuesday, October 14, 2003
[[=] Tap herebosst owner information

Important
- The graphic above shows an example of a PDA operating window.
The connection procedure may be different depending on the manufacturer or
model of PDA you use. Please refer to the product instruction manuals for further
details.

The [Bluetooth Settings] window will open.
The message "Connection not registered" will appear if no Bluetooth device has
been registered.

T

34 |Bluetooth Sett ::!':' s ®E 12:01

i Bluetooth Settings

Connection registration
& could not be performed.
Before establishing a
Bluetooth connection,
selact the service to which
You want to connect and
ragater the cormacton,

This message = dsplayed at the
tirne of starbup.

]

Tools View Dptions O =8

| e

Please tap on [OK] to close the message.

2. Double click on [Tools]>[Search for peripheral components].
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£F |Bluetooth sett ‘P 2t £ 12:06 (D

Femote Devices Status

Service Mame | Status Diescription

Device Search

Search Options r
Delete Ghost Devices...

Tools| ¥iew Options Q E|‘
T

The application searches for nearby Bluetooth devices.
3. Tap and hold on the destination PC icon, and then select [Update Services].

£F |Pluetooth Sett *1* &t <1211 (D |

Service Name | Status | Description

|Tools ¥iew Options CF EI-‘-

A search for services will be carried out, and then a list of service names and their
connection status will appear as list in the lower window.




Service Mame | Status I Description

Pl COM7 Mot C...  SerialPort(T..,
File Trans... Mot C... OBEX File Tr...
Ohject P... Mot C... OBEX Chiec...

Tools ¥iew Options q E|‘

Tap and hold on "COM7" from the list of service names, and then select

4.
"Register ActiveSync".

Service Mame | Status Description

b =
EFie T
; Connection Registration
[ objec g g
Properties

Tools Yiew Options q El“

5. Tap [OK] in the confirmation message window.
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ActiveSync Auto Connect,
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0K Cancel

SETVICE e [ oranas

LIESCHETIOn

iii---l._l._ilf'-'l.? Mot C...  SerialPort(T...
EYFile Trans... Mot C... OBEX File Tr...
ﬁ'ﬂ@hject P... MotC... OBEX Obijec...

Tools ¥iew DOptions q E|‘

An ActiveSync connection will be initiated.
Establishing a partnership between ActiveSync and a PDA

Once a connection has been successfully established with a PDA, the procedure for

establishing a partnership with the PDA will be started by the ActiveSync application on
the PC.

Performing this set-up procedure will enable data to be synchronised between your PC
and PDA.

1. In the [New Partnership (Set Up a Partnership)] window, select "Standard

partnership”, and then click on the [Next] button.
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Hew Partnership

Set Up a Partnership

Thizs wizatd helps pou establish a paiineship between you
mobile desice and this computes. “fow can set up sther a
standard partnesship o synchionize data bebwesn pour
device and this compuler. of & guest paitrseship bo seply
tranzher data between your device and thiz compuber.

‘What kind of partnesship would you like to establsh bebwesn
wour device and this computes?

(* [Standard parinesshig
| weant to synchronize data bebsesn my device and
this computer, keeping data such az e-mail and
calendar tems upto-dale in both places

™ Guest partnesship
| weant bo anle copy and move infoimation bebween my
device and thiz computer, add and remove programs,
of restole & backup mage on a davice whose memony
haz been reset. | do not weant to syncheorsze data.

Blest = Cancal | Help |

The [New Partnership (Specify Data Synchronisation Method)] window will appear.

2. Select "Synchronise with this PC", and then click on the [Next] button.

Specily how to spnchronize data
Chioose to synchiorize with yowr desklop andfor a server

Hew Partnershap
W

*ou can synchronize data, such as e-mal meszages and calendas ibems, bebween pour
dievice and this dezklop computer. However, if you have access bo a Mictosoft Exchange
Server with Exchange ActiveSpnc, you can also choose some infoemation types fo
symchionze dirscty with a sarver, geting te most up-to-date infomation, evan whean pour
desklop computer i luned off

Heww do wou want bo sypnchionize with pour device?
= Syncheorize wih this deskiop computed
™ Syncheorize with Miciozoft Exchangs Server and/or this desktop computar

[Mote: ‘fou musl have aceess 1o Miciozalt Exchange Server with Exchange ActiveSyne
or Micsozodt Mobde Information Senver. )

¢ Back Mesd Cancel | Help

The [New Partnership (Select Synchronisation Settings)] window will appear.

3. Select the type of information to be synchronised between your PC and PDA,
and then click on the [Next] button.
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Hew Partnership

Select Synchronization Settings m
Selact the e of irfoimation wou want b snchionize MR

To smchionize a parficula type of information, select k2 check box To stop
sprchronization of thal nformation, clear its check box

Mobie Device | Deskiop Compuier [~
B o e e e e
w| =) Calendar Micrazoft Dutlock:
| [[= Contacts Microsoft Dullock
v 3 Favonbes Interret Exploner
| (e8] Fles Synchionizad Files
1 [ by Mictosoft Dutiook
o) Notes Microzoft Oullock an

To fird out more sbout and to customize what gets synchionzed, click
on that mbormation pe in the kst and then chck Sethngs

¢ Back Mesd Cancel | Heip |

The [New Partnership (Completing Setup)] window will appear.

4. Click on the [Finish] button.

Hew Partnersap

Setup Complete

Tou ane now eady o dait exchangng infomation batween
wour mable device and his compules

Upon exling this wazand, Mictosoll ActveSyne will open and

If your device s a guest, chck Explore on the toolbar and
ztart exploring your device

It wour dewice has a parinership, syncheonization starts.
Flease wail until synchiorization is complate before using
your dewice.

Chck Firish bo et this wezard

Cancel | | |

When you click on the [Finish] button, ActiveSync will begin to synchronize your
information.

[Confirming changes]
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[Synchronization complete]
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Information Type Skatus

Flcalendar Synchronized
FEcantacts Synchronized
[z] Tasks Synchronized
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e Synchronized

While the ActiveSync connection is active, synchronization will be performed
whenever information is changed on either the PC or the PDA.

Once a partnership has been established, every time you start your PC (and PDA)
thereafter, a Bluetooth connection will be opened and ActiveSync will synchronize
your information.

Finishing an ActiveSync connection

Tap and hold on "COM7" in the Bluetooth Settings window, and select
[ActiveSync Release].




Service Mame | Status Description

ﬁ'ﬂ@hject p Connection Registration
Properties

Tools ¥iew Options q E|‘

Cancelling a partnership
Click on [File]>"Delete partnership".

Click on the [Yes] button when the confirmation message appears.

|@'Micmsuﬂ ActiveSync |;] E
Fle ‘iew Tool: Help

Iobile Device [

Dedete Partnership

Get Connected..
Connection Settings. ..
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4.6 Fax transmission
4.6.1 Using a modem station for fax transmission

Important

- Please refer to the modem station instruction manual for information on how to
connect the station to a telephone line.

- Please ensure that any drivers used to connect the PC to the modem have
been installed.

- A Bluetooth passkey (PIN code) is required for you to connect to the modem
station. Please make a note of your Bluetooth passkey before you start the
set-up process.

- A fax application is required for you to be able to send and receive faxes. The
description below is based on a example using Microsoft Fax, which is installed
with Windows XP as standard.

If you are going to use a commercially available fax application, then please refer
to the manual that came with the application for information on how to send and
receive faxes.

Setting up the modem station
1. Turn on the wireless modem station.

2. Right-click on the Bluetooth icon in the task tray, and then click on [Add New
Connection].

Bluetooth Settings

Add Mew Connection
Dienvice Properties

Poweer OFF

Ciplions [

Hedp

Note
- Alternatively, click [Start]—[All Programs]—[Bluetooth]—[Bluetooth Settings],
and then click on [New Connection] from the active [Bluetooth Settings] window.
The [Add New Connection Wizard (Welcome to the Add New Connection
Wizard)] window will appear.

3. Select [Custom Mode], and then click on the [Next] button.
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Add New Connection Wizard

Wealcome to the Add New Connection Wizard

Thiz vazard regisbers the connechon infomation of & remobe
dawvica.
Select the wizard mode.

() Exprezs Mode [Recommended)
The miost useful zervice on a remobe device iz set up,

(%] Cuztom Mode
An avalable service on a remole device 13 seleched and set

[ bew> | [ Cancal ||

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will
appear.

"hld Hew Connection Wizard

Searching for Bluetooth devices.

Seaiching for Blustooth devices.

Once the program has finished searching for the devices, the [Add New
Connection Wizard (Select Device)] window will appear.

4. Select the device name of the wireless modem station from [Device List], and
then click on the [Next] button.






